Coverage Tutorial Using the Object Model

This tutorial shows how to use the STK Object Model to set up a simple coverage
analysis, performing tasks for which you might otherwise use Connect or the STK GUI.
Source code is given in C# and Visual Basic.NET. Familiarity with Microsoft Visual

Studio and STK are presumed.

Source Code Location: The source code for this tutorial is in the following text file:

<STK Install Folder>\Help\LinkedDocuments\OM CoverageTutorial.txt

The code is broken into sections corresponding to the sections in this tutorial. Within
each section, the C# and VB.NET code are presented in separate subsections.
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Where to Get Help

Before proceeding with this tutorial, take a moment to familiarize yourself with the parts
of the STK Programming Interface Help system that relate to the Object Model and

STK X.

In the Contents tab of the Help system, navigate to Using Core Libraries = STK Object

Model > STK Objects.
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Try this: To find help for the AgStkObjectRoot class discussed above, click Library
Reference>STK Object Model>STK Objects and scroll down the alphabetical list until
you find the entry entitled "AgStkObjectRoot". Click AgStkObjectRoot to display a page
containing a diagram with several links, including a link to Root (IAgStkObjectRoot
Object). From that page you can access a page that lists all the members (methods and
properties) of the interface associated with the AgStkObjectRoot object. Similarly, you
can find help for any other object or interface, as well as any method, property or
enumeration.
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A quick way to find help on a given type is to use the Search tab of the Help system. For
example, suppose you are interested in the AgECoordinateSystem enum. If you enter
"AgECoordinateSystem" in the search field and click List Topics, a list of pages
containing that term appears. Click on the Title heading to order the list alphabetically,
and the entry for AQECoordinateSystem will appear at the top. Click that entry to display
a page defining the enum and listing its members.

Tip: Keep the STK Programming Interface Help system open to the Search tab
while you are working through this tutorial. Then you can copy and paste the
names of interfaces, enumerations, etc. into the search field to learn more about
their meaning and usage.

NOTE: It is not necessary to have STK running to display the Help system. To
launch Help, simply open the Windows Start Menu and navigate to to All
Programs >STK 11 = Help = STK 11 — Programming Interface.

In addition to the Object Model (STK Objects and STK Util), you may find it useful to
refer to help on STK X controls.

One final note on the STK Programming Interface help: In addition to help on
programming issues, the help provides information about the real-world context in which
the application is to be used. For example, the help page for the SpinAxisConeAngle
property tells you that it is writable, is of the Variant data type, and belongs to the
[AgSnPtSpinning interface. In addition, it tells you that the property represents "the cone
angle used in defining the spin axis; i.e., the angle between the spin axis and the sensor
boresight." This latter information is useful in deciding whether and how to use the
property in your application, but it is necessarily somewhat sketchy, since the help is
mainly intended to provide guidance on programming issues. However, in the STK Help
System, there is generally more information. For example, the help page for “Spinning
Sensor Pointing” not only gives more detailed context information but also includes a
drawing of spin axis geometry that illustrates the spin axis cone angle quite clearly.

Tip: For real-world context information on the Object Model types that you use
in your application, do not rely solely on the brief definitions in the Object Model
help. Refer also to the STK Help System.

Start Visual Studio and Create your Project
You will use two STK X controls for this tutorial. To add these controls and to use the
STK Object Model, you must add the following COM references to your project:
e STK Objects —a COM Library containing types, interfaces, events and classes
representing various aspects of the STK application structure.
e STK Util — a library containing objects and enumerations shared by the STK
Objects and STK X type libraries.
e STK X - acollection of COM components and ActiveX controls that use STK
Engine technology.
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Here are the steps to set up your project and add the necessary references:

1. Start Visual Studio and click on File and then New Project.

2. Under the Installed templates, navigate to Templates, select either Visual Basic or
C#, then in the Windows page choose Windows Forms Application. Configure the
rest of your project settings as you see fit. In this tutorial, CoverageTutorial is
used as the project name.

3. Once your new project has loaded, open the Solution Explorer in the View tab,
right-click on the project name, and then select Properties.

4. Click on the Build tab in the properties panel if using C#. Go to the Compile tab
for Visual Basic

5. For C#, in the Platform target field, select “x86”, and then close the properties
panel. For Visual Basic, in the Target CPU field, select “x86”, and then close the
properties panel.

6. Finally, click on the Project menu and select the Add Reference... menu item.
Select the COM tab and add the following references to your project:

e AGI STK Objects 11
e AGISTK Util 11
e AGISTKX 11

Add STK X Controls to your Form

Before you begin writing Object Model code, use the design view in Visual Studio to
draw the user interface for your custom application. When you are finished, the GUI you
create will look something like this:

4! Coverage with the STK Object Model e
Select Action... -
Current 3-D Splash Screen Animation
.
|

Current 2-D Splash Screen
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The application that you create allows the user to:

Create a Scenario and display it in 2D and 3D windows.

Control the animation of the scenario.

Select various actions from a combo box: define a coverage region, compute
coverage, select a figure of merit and display the quality of coverage graphically
in the 2D and 3D windows.

Here are the steps to create the GUI:

1.

10.

Display the automatically-generated Form1 in design view and stretch the form
so that it is approximately square and substantially fills the available workspace
(with Visual Studio maximized). Display its properties page and change the Text
property from “Form1” to “Coverage with the STK Object Model”.
If the Toolbox is not already in your workspace, then add it by clicking on
View->Toolbox from the menu. Right-click on a blank area in the General section
of the toolbox (i.e., neither a control nor the Toolbox title bar), and select Choose
Items... from the drop-down menu.
From the dialog, select the COM Components tab and add the following
components to your project by selecting the checkboxes next to their entries:

e AGI Globe Control 11

e AGI Map Control 11
Click OK to close the dialog.
From the Forml design view, find AGI Globe Control 11 in the Toolbox, and
draw a rectangular shape in the upper left region of your form. Do the same thing
with the AGI Map Control 11 in the lower left region of the form.
Place a ComboBox in the upper right corner of the form.
Display the properties page for the ComboBox, change its Text property to
"Select Action...". Afterwards, set the Enabled property to False — the code in the
.txt file will enable this after a new scenario is created.
Place a button below the ComboBox and change its Text property to "New
Scenario".
Place a GroupBox below the "New Scenario" button and stretch it so that it will
accommodate 6 buttons, arranged vertically. Change its Text property to
"Animation".
Arrange 6 buttons vertically in the GroupBox. Set the Enabled property for all of
the buttons to False. Starting with the top button and working down, set the Text
properties of the buttons to:
e Play Scenario
e Pause Scenario
Reset Scenario
Play Backward
Slower
Faster
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This completes the artistic part of this exercise. Now, on to coding with the Object
Model.

Set the Scene for the Coverage Analysis

Add the Core of the STK Object Model to your Project

Refer to OM_CoverageTutorial.txt for the code segments to be added in this section.

Begin by adding statements at the beginning of the code (using in C#, Imports in
VB.NET) to gain access to the types defined in the STK Objects and STK Util libraries.

Next, define and initialize an instance of AgStkObjectRoot, the top level object in the
Object Model hierarchy, which exposes a set of methods and properties that you will find
indispensable in implementing the Object Model in your application. To name just 3
examples, this class includes the following methods:

e NewScenario(): creates a new STK scenario.

e LoadScenario(): loads a scenario file on a specified path.

e ExecuteCommand(): takes a string representing a Connect command as an

argument and executes the command.

Finally, add the OnFormClosing method to close STK Object root properly, as indicated
in OM_ CoverageTutorial.txt.

Create and Populate a Scenario

Referring to OM_CoverageTutorial.txt, add a function to create a new scenario to the
main body of the Form1 class and populate it with two satellites. Then add a call to that
function to the Click event for button you created.

At this point you should be able to build and run your application. Click the button to
display the 3D Globe and 2D Map:
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More detailed discussion of the interfaces, methods and properties made available by the
Object Model for creating and configuring satellites can be found in STK Tutorial Using
the Object Model.

Animate the Scenario

Add the appropriate method of the AgStkObjectRoot object to the appropriate Click
method of each of the animation buttons that you drew on Form1:

Button text Code in Click method
Play Scenario root.PlayForward ()
Pause Scenario root.Pause ()

Reset Scenario root.Rewind()

Play Backward root.PlayBackward ()
Slower root.Slower ()

Faster root.Faster ()

If you are coding in C#, of course, you need to add a semicolon (;) to each of those
method statements.

Build and run the application, create a scenario, experiment with the animation controls,
and observe the results in your 2D and 3D displays.
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Coverage with the Object Model

Create a Coverage Definition

In the STK GUI, a coverage grid is defined using the coverage definition's Basic—> Grid
page. Here, for example, using Latitude Bounds, a grid is defined to cover a tropical
region (between 23.5 deg north and south of the Equator), with a resolution of 3 deg
between grid points:

(@ Compute Locations Based on Granularity
() Custom Locations Specify.

Custom Point Altitude Method: | Uz File Valuss

Grid Constraint Options...

« 11 r

[ ok || cancel |[ Aepy |[ Hep |

In this exercise we have broken the process of creating a coverage definition, defining its
bounds and setting its resolution into three methods, so that we can see the effect of each
separately.

Referring to OM_CoverageTutorial.txt, the coverage definition is created with a single
line of code, invoking the New method of the IAgStkObjectCollection interface, which
takes as arguments an enumeration member representing the class of the new object (in
this case AgESTKODbjectType.eCoverageDefinition) and an instance name ("Tropics").
The Children property is used to indicate that the new object is a child of the current
scenario.

A variable representing the coverage definition needs to be added to the Form1 class,
where it will be available for use by other methods in that class. At this juncture, you will
also add (to the Form1 class constructor) the code needed to populate the combo box.
Finally, you will add to the SelectedIndexChanged method of the combo box a call to the
CreateCovDef() method.

NOTE: The SelectedIndexChanged() method includes calls to the BeginUpdate()
and EndUpdate() methods of the AgStkObjectRoot class. The BeginUpdate()
method suspends graphic updates, which helps speed up processing of a block of
code. The graphic updates are then carried out in a batch when you invoke
EndUpdate().
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Now build and run the application, create a scenario, and select Create Coverage
Definition from the combo box:

Coverage with the STK O

New Scenario

Animation

| PlyScenaio
| Rewind Scenario

| PlayBackward
—
| Faster

Set Coverage Bounds

The CoverageBounds() method gets the reference to the IAgCvGrid interface from the
coverage definition's Grid property, then it configures the IAgCvBoundsLat interface of
the Bounds property of IAgCvGrid. Latitude bounds are then set using the MaxLatitude
and MinLatitude properties of [AgCvBoundsLat.
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Again, add a variable to the Form1 class and update the SelectedIndexChanged() method.

Now build and run the application, create a scenario, and select Create Coverage
Definition and Set Coverage Bounds from the combo box:

Set Coverage Bounds

New Scenario

Animation

| PlyScenaio

[ Pause Scenaio |

| Rewind Scenario
Earth Ir ] ) : . / . - Sower |

5 ah

| Faster
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Set Coverage Resolution

The CoverageResolution() method uses only one interface, IAgCvResolutionLatLon,
which is initialized to the Resolution property of the IAgCvGrid instance that was
introduced with our CoverageBounds() method. (This is why you had to declare the
variable representing that instance at the Form1 level.)

lf 1AgCvGrid B
B BoundsType
1 Bounds
B ResolutionType
—l Resolution
e S

Y

" I1AgCvResolution

}

|'/ lAgCvResolutionLatLon
‘ B Latlon

N i

1/

-\\I

Using the LatLon property of I[AgCvResolutionLatLon, set the resolution to 3 deg.

After updating the SelectedIndexChanged() method, build and run the scenario, and
select Create Coverage Definition, Set Coverage Bounds and Set Coverage Resolution
from the combo box:

Coverage with the STK

New Scenario

Animation

—
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Compute Coverage

The ComputeCoverage() method carries out the actual computation of coverage in a
single line, but that line is preceded by code to assign the coverage assets and configure

graphics properties.

In the STK GUI, the coverage definition's Basic — Assets page lets you assign the
coverage assets (in this case, the two satellites) and set their Status (active or inactive),

among other things:

=} Tropics : Basic

=)

=] Basic
~ Grid
o Assets*
- Interval
- Advanced
. Description
[=]12D Graphics
i Attributes
=130 Graphics
. Attributes

| ok || Cancsl

J |

oply | [ Hep

)

[~ Require Asset
Status
Active -

Grouping

Constellation

Use Constraints

In the Object Model, the above assignment uses the [AgCvAssetListCollection interface,

which is retrieved from the coverage definition's AssetList property.
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/-IAg CvAssetListCollection

] Count
- Item
1 AvailableAssets
A RemoveAt
A Removerll
A Add
A Remove
N A

I-/— lAgCvAssetlistElement ™

B AssetStatus
B Grouping
1 ObjectName
3 v

Using the Add method of the IAgCvAssetListCollection interface, the two satellites are
added by passing their object paths. The Add method returns an IAgCvAssetListElement
interface; in the tutorial we set the AssetStatus to active.

To set 2D graphics properties of the coverage definition in the STK GUI, use its 2D
Graphics — Attributes page:

B Tropics : 20 Graphics Attributes EI@
=l Basic ] Show
Grid
Grid Satisfaction
Assets * ) =
Interval - [] Show Satisfaction
Acanced Show Region Labels Color [:]
Description [v]show Poirts
i % Translucency: | /U.LULULLU
= 2D Graphics Color: E}
Attributes * Paints
=1 3D Graphics Il Progress of Computations
Attributes Marker Style: Show
% Translucency: 50.000000 I B E
[ ok || cancel || Aoy || Hep |

The options selected here:
e Display the boundary of each coverage region in the 2D Graphics window,
together with its name.
e Show each grid point as coverage computations are completed.
e Display coverage regions and points as filled polygons.
e Highlight grid regions and points as accesses are being computed.
¢ Disable satisfaction graphics.
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The Object Model provides a hierarchy of interfaces under the coverage definition's
Graphics property to let you make the above settings:

|/- IAgCvGraphics \l

1 Stafic

1 Animation

1 Progress

v V Vv

I1AgCvGfxStatic N ( IAgCvGfxAnimation \ ( 1AgCvGfxProgress \l
B IsRegionVisible B IsSatisfactionVisible B IsVisible
M IsPointsVisible B Color Bl Color J
B IsLabelsVisible \
| Color
M FilPoints
B MarkerStyle
A A

o The IAgCvGfxStatic interface lets you set the region, label, point and fill display

options.

o The IAgCvGfxProgress interface lets you set the options related to progress of

computations.
e The IAgCvGfxAnimation interface lets you configure satisfaction graphics.

After these settings are made, invoke the coverage definition's ComputeAccesses()

method, corresponding to the Compute Accesses option in the coverage definition's tools

menu in the GUI.

After updating the SelectedIndexChanged() method, build and run the application, then
select Create Coverage Definition, Set Coverage Bounds, Set Coverage Resolution and

Compute Coverage from the combo box:
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In the STK GUI, after creating a figure of merit object as a child of the coverage
definition object, you can use its Basic — Definition page to select the type of figure of

merit you want and to set its Compute option:

=1 TwoEyes : Basic Definition EI@
= B 1
(=) Basic n— Definition Satisfaction o
Definition * et
Description Type: | M Asset Coverage Bt | =
=] 2D Graphics Compute: | PP = | Satisfied ff: | Greater Than
Animation —
s Threshold: 0 =]
Static e
=130 Graphics ) )
Attrbutes Invalid Data Indicator
Value: 0 |@ =
FOM Values Limits
Use FOM Value in L
Min: 0O |§|
Max: 0 |@
Exclude FOM Value in Limits
[ ok ][ Cancd |[ Mooy |[ Heo |

Here N Asset Coverage is selected, which measures the number of assets available
simultaneously during coverage, with the Maximum Compute option; i.e., the maximum
number of assets available over the entire coverage interval.
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In the Object model, the figure of merit object provides a SetDefinitionType() method for
selecting the type of figure of merit, and an interface available via its Definition property
lets you set the compute type:

~

IAgFigureOfMerit N

DefinitionType
DefinitionSupportedTypes
Definition

Graphics

VO

SetDefinitionType
IsDefinition TypeSupported

SetAccessConstraintDefinition

4

PP ODLOOODO

-

(" IAgFmDefinition

‘ 1 Satisfaction

\ J

A

7 IAgFmDefCompute h

ComputeType
ComputeSupported Types
Compute

SetComputeType

b L L L

IsComputeTypeSupported
\ i

In the STK GUI, to configure the display of the figure of merit in the 2D Graphics
window, use its 2D Graphics — Animation and Static pages:
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=] TwoEyes : 2D Graphics Animation =5 [E=E

=) Besic : [] Hide Al Animation and Static Graphics
- Definition
Description Show Animation Graphics
;l?D Graphics Show Points As Accumulation
Static * 2
(513D Graphics LS
Attributes % Translucency: | 70.000000
Display Metric
(Z) Show Satisfaction
(@ Show Cortours
Levels
Level Adding Level Attributes
ot e B 7 [ Catr et (]
1
Start: 0 —— [(Remore |
Step: 0
&l Dio not show areas where FOM value
Add Levels excesds max contour evel Copy Static Levels
Cortour Interpolation (points must be filed)
@ Mone (Block Fill)
Natural Neighbor Sampling: | Medium Sampling 5.000000
< | m r
o) o) ] )

Among other things, options were selected to use markers instead of fill for static and
animation graphics, and use Current Time as the Accumulation option; i.e., when
animating, only grid points that currently meet the satisfaction criterion are highlighted.

In the Object Model, most of the above settings are made using the IAgFmGfxAttributes
interface, which is instantiated first to the Static then to the Animation property of the
[AgFmGraphics interface:
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(- IAgFmG.raphics
1 Static

J  Animation

\. =

q.--------

IAgFmGxAttributes

IsVisible

Caolor

=

s

B FilPoints
B MarkerStyle
I |

Contours.

( _IAgFmexAttributesAnimation \

B Accumulation ‘

S

A separate interface is provided for setting the Accumulation option.

The method you have created to define the figure of merit for this tutorial also includes
code to turn off static graphics for the coverage definition.

After updating the SelectedindexChanged() method, build and run the application, then
select Create Coverage Definition, Set Coverage Bounds, Set Coverage Resolution,
Compute Coverage and Create Figure of Merit from the combo box:
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Create Figure of Merit

New Scenario

Animation

| Play Backward |
 Sower |

| Faster

Set Satisfaction Criterion
Defining satisfaction criteria is handled in the STK GUI using Satisfaction options on the
figure of merit's Basic — Definition page:

S atisfaction

Enable

Satisfied if: | At Least w

Threshold: |2
Here we are requiring that at least two assets (satellites) have access to a given grid point.
In the Object Model, satisfaction criteria are set using the [AgFmSatisfaction interface,

made available by the figure of merit's Definition property via the IAgFmDefinition
interface:
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IAgFigureOfMerit e

DefintionType
DefinitionSupportedT ypes
Definition

Graphics

VO

SetDefinitionType

IsDefinitienT ypeSupported

P L LLLL

SetAccessConstraintDefinition

-

2

vV

(" IAgFmDefinition ™

‘ 1 Satisfaction

AN >4

T
]

v

|/ |AgFmSatisfaction -\I

EnableSatisfaction

=

B SatisfactionType
B SatisfactionThreshold
=

InvalidDatalndicator

b o

After updating the SelectedIndexChanged() method, build and run the scenario, then
select Create Coverage Definition, Set Coverage Bounds, Set Coverage Resolution,
Compute Coverage, Create Figure of Merit and At Least Two from the combo box:
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- Coverage with the STK

New Scenario

Animation

| PlayScenaio
[ Pause Scenaio |
| Rewind Scenario

| FPlayBackward
. Sowsr |

| Faster

Display Coverage Contours
In the STK GUI, to set up animation contours to show the degree of satisfaction of the
figure of merit (by one or both assets) dynamically, use its 2D Graphics — Animation

page:

] TwokEyes : 2D Graphics Animation EE
i s | Hids All Animation and Static Graphics
Definition
Description 7] Show Animation Graphics
= 2D Graphics Show Points As Accumulation
Animation * @ Markers 3£ - Show ‘mmm“m:]
Static *
=130 Graphics e foa
Attributes % Translucency: | 70.000000
Display Metric
Show Satisfaction
@ Show Contours
Levels
Level Adding Level Attributes
Add tthod (St Sop. Sep v ["Lovel] Sator Colr Method: [Bpict.__ =
= I —
Sar: 0 = 2 [ ] { Remove J
5 i | ]
Stop: 0 E Remave All
Step: D =
Legend...
(e Do not show areas where FOM value —_———————
[ Add Levels ) [ Copy Static Levels
Contour Interpolation {poirts must be filled)
o
« I »
ok | [ Concd | [ mppy | [ Heb
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Here we have opted to show animation contours and have used the Explicit color method
to assign a color to each level of satisfaction of the figure of merit (by one or both
satellites).

In the Object Model, use the IAgFmGfxContours interface and two interfaces that it
makes available to set the above options:

e IAgFmGfxContours 2

IsVisible
ContourType
ColorMethod
RampColor

LevelAttributes

LLLENERN

Legend

Vi

/—iAgFmexLeveIﬂttril)utesCollemion ™
1 Count

Item
RemoveAt
RemoveAll

AddLevelRange

| N N

AddLevel

<}------

I'/_ |1AgFmGfxLevelAttributesElement \
B Level
B Color

L _/

The IAgFmGfxContours interface is available via the Contours property of the
[AgFmGfxAttributes interface

The method used in this tutorial to set up animation contours first turns off the figure of
merit's static graphics, then leverages the above interfaces to turn on animation contours,
add two contour levels and assign a color to each.

After updating the SelectedIndexChanged() method, build and run the scenario, then
select Create Coverage Definition, Set Coverage Bounds, Set Coverage Resolution,
Compute Coverage, Create Figure of Merit, At Least Two and Contours from the combo
box. Then animate the scenario and watch the changing graphics display in the 2D and
3D windows:
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